NOTICE

The information in this document is subject to change without notice and should not be construed as a commitment by ABB Inc. ABB Inc. assumes no responsibility for any errors that may appear in this document.

In no event shall ABB Inc. be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB Inc. be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB Inc., and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license.

This product meets the requirements specified in EMC Directive 89/336/EEC and in Low Voltage Directive 72/23/EEC.

Copyright © 2004 ABB Inc.
All rights reserved.

Release: May 2004
Document number: 3BUF001113D1 Rev A

TRADEMARKS

Registrations and trademarks used in this document include:

Windows Registered trademark of Microsoft Corporation.
ActiveX Registered trademark of Microsoft Corporation.
PostScript Registered trademark of Adobe Systems Inc.
Acrobat Reader Registered trademark of Adobe Systems Inc.
<table>
<thead>
<tr>
<th>Section 1 - Introduction</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Prerequisites</td>
<td>6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section 2 - Fixed Problems</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section 3 - Installation</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>13</td>
</tr>
<tr>
<td>Preparing Your Computer for Patch Installation</td>
<td>13</td>
</tr>
<tr>
<td>Preparing an Information Management Server</td>
<td>14</td>
</tr>
<tr>
<td>Stop All Processes under PAS Supervision</td>
<td>14</td>
</tr>
<tr>
<td>Stop the PPA Server</td>
<td>15</td>
</tr>
<tr>
<td>Stop SQL Server MSSQLServer Service</td>
<td>18</td>
</tr>
<tr>
<td>Preparing System Nodes that Use the Client Toolkit</td>
<td>19</td>
</tr>
<tr>
<td>Preparing Remote PC Clients</td>
<td>19</td>
</tr>
<tr>
<td>Installing the Patch</td>
<td>20</td>
</tr>
<tr>
<td>Verifying Patch Installation</td>
<td>26</td>
</tr>
<tr>
<td>Setting Log On Settings for Information Manager Services</td>
<td>28</td>
</tr>
<tr>
<td>Setting the ADO Data Provider to Automatic</td>
<td>31</td>
</tr>
<tr>
<td>Configuring the Softpoint Server</td>
<td>35</td>
</tr>
<tr>
<td>Bringing a New Softpoint Configuration On-line</td>
<td>38</td>
</tr>
<tr>
<td>Restart Calculations</td>
<td>40</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section 4 - Using the New DataDirect Tools</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Log In</td>
<td>42</td>
</tr>
<tr>
<td>Using the New Process and History Values Dialogs</td>
<td>42</td>
</tr>
<tr>
<td>Browsing and Selecting Objects</td>
<td>42</td>
</tr>
</tbody>
</table>
Specifying One-time Data Access or Reusable Formulas .................................. 44
Interrupting the Retrieval of Selected Objects .................................................. 44
Setting Up the DataDirect Menu and Tool bar .................................................. 45
Functions .............................................................................................................. 46
ABBGetOPCDASimple ..................................................................................... 46
ABBWriteOPCDA ............................................................................................ 47
ABBGetOPCDA ............................................................................................... 48
ABBGetOPCHDA ............................................................................................ 49
ABBGetOPCHDAAggregates ........................................................................... 52
ABBWriteNOPCHDA ....................................................................................... 53
ABBWriteOPCHDA .......................................................................................... 56
Updating the Excel Spreadsheet ................................................................. 57
Section 1 Introduction

These release notes describe patch 6a for Inform IT Information Manager version 3.5/2. This patch must be installed on all Information Management server nodes, all system nodes that have the Information Manager Client Toolkit installed, and all remote PC clients that have the Information Manager Desktop tools. This patch fixes several problems that were seen to occur in History Services and the DataDirect and Desktop Trends user interfaces. This patch also includes bug fixes and enhancements which were originally released with earlier patches for Information Manager version 3.5/2. These are briefly described below:

- **History Services:**
  - When updating every value for a month of data sampled at 1 minute intervals, blocks of values failed to get updated within that time range. With this patch all values get updated correctly.
  - The problem related to one-character property names is fixed.
  - The problem is related to writing data with bad data quality to a history log is fixed.

- **DataDirect:**
  - enhancements that facilitate data access from aspect objects in Process Portal A.
  - A problem with the new DataDirect OPCHDA and OPCDA functions is corrected so they may be used in multiple-sheet workbooks.
  - Two new functions were added to DataDirect to let you update history logs with entries that have microsecond resolution.

- In **Display Services**, you can now embed custom graphics as ActiveX controls in Process Portal A.

- In **Report Services**, Excel-based reports retrieved from a report log will
Section 1 Introduction

properly display charts.

- In **Scheduling Services**, time-based schedules no longer have time-shift problems when the server goes off line and misses a scheduled job execution. Also, the scheduler is no longer prevented from running due to a missing license.

- The Process Portal A patch (part of PPA 2.1/2 SP1 or newer which is required for this correction) fixes the *Invalid Item ID* error that occurred when a data access application issued multiple queries through the Process Portal A OPC/DA server, and each query specified a different tag.

- In **Softpoint Services**, a memory leak in the ADVOs OPC Connector Data Service was fixed and the proper files were included in this release.

For further information regarding these fixed problems, see **Section 2, Fixed Problems**. For details regarding the new functionality, refer to **Section 4, Using the New DataDirect Tools**.

**Prerequisites**

The DataDirect enhancements require Process Portal A version 2.1/2 SP1 to be installed locally on the node where you run DataDirect.

Further, all data servers from which you will retrieve data must have Process Portal A version 2.1/2 SP1 to support the new functionality. This new functionality cannot be used on remote PC clients.

Install patch on all Information Manager server PCs. The server must be stopped via the Operate IT Configuration Wizard, and certain Information Manager applications must be removed BEFORE you begin installing the patch software. Detailed installation instructions are provided in **Section 3, Installation**.
Section 2 Fixed Problems

The problems fixed by this patch are described in Table 1. Problems fixed by previously released patches that are included in this patch are described in Table 2.

Table 1. Problems Fixed By Patch 6a

<table>
<thead>
<tr>
<th>Component</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>History Services</td>
<td>3020</td>
<td>Patch repackaged due to a build error. Incorrect Batch DLL added to project. Correct BatchPDL.dll now included.</td>
</tr>
<tr>
<td></td>
<td>2961</td>
<td>When Information Management history logs collected from Process Portal A trend logs, for logs whose data was not changing, <em>noData</em> entries were inserted into the history log after the last value received prior to the shutdown of the Information Manager, and again just before the next value received after the Information Manager was started. This problem has been fixed</td>
</tr>
<tr>
<td></td>
<td>2953</td>
<td>Parse samples would sometimes drop a value for data not changing. This has been fixed</td>
</tr>
</tbody>
</table>
| | 2939 | History collection used too much memory under these circumstances:  
• when time was set ahead (for test purposes)  
• when data was not changing  
This problem has been fixed |
| | 2928 | The *in difficulty* diagnostic is now disabled by default. This diagnostic may be enabled by test/service personnel for test purposes. |
| | 2924 | Restored reports may now be viewed |
Section 2 Fixed Problems

Table 1. Problems Fixed By Patch 6a (Continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>History Services</td>
<td>2868</td>
<td>A current time noData Values is no longer inserted when a user_supplied configured with StoreAsIs a activated.</td>
</tr>
<tr>
<td></td>
<td>2702</td>
<td>A check has been added to prevent negative times from being sent to strftime. This would cause history to crash.</td>
</tr>
<tr>
<td></td>
<td>2405</td>
<td>The problem that caused the history synchronizer to crash and corrupt log IDs has been fixed.</td>
</tr>
<tr>
<td></td>
<td>2369</td>
<td>See 2939.</td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>History would crash if there were several Information Manager history logs collecting from the same Process Portal A trend log, and the blocking rate for each Information Management history log was different. This problem has been fixed.</td>
</tr>
</tbody>
</table>
| Desktop Trends     | 2942| Two conditions that caused an overflow error when using the Desktop Trends display have been fixed:  
 |                    |      | 1.) An overflow error will no longer occur when a trace selected for the viewing on the Trend Statistics dialog contains more than 3200 points |
|                    |      | 2.) An overflow error will no longer occur when using a large time scope (for example, one week), and then stepping using the << or >> buttons. |
Section 2  Fixed Problems

Table 1. Problems Fixed By Patch 6a (Continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1509</td>
<td>DataDirect no longer hangs when trying to log in to PDL without an available license.</td>
</tr>
<tr>
<td>DataDirect</td>
<td>1987</td>
<td>Interaction between message filter and output selection on the Alarm/Event tab of the DataDirect message Log dialog has been fixed. The tag name output selection option is no longer removed from the output selection list when you specify a tag name in the tag name filter. Open data direct and call up the window to request message log data. 2. specify a tag_name in the filter 3. go to add tag_name in the output selection. You can't - it has disappeared</td>
</tr>
<tr>
<td></td>
<td>2734</td>
<td>The History tab on the DataDirect PDL Output dialog no longer generates type mismatch errors when the retrieval type is set to Raw Data and the Number of values is set to MAX. This entry is now properly interpreted as a number rather than a text string.</td>
</tr>
<tr>
<td></td>
<td>2930</td>
<td>The Log Name list in the DataDirect Message Log dialog no longer duplicates the names of restored message logs when more than one instance exists for a restored message log.</td>
</tr>
</tbody>
</table>
Table 2. Problems Fixed in earlier Patches Which are Included in this Patch

<table>
<thead>
<tr>
<th>Component</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>History Services</td>
<td>2524</td>
<td>Prior to installing this patch, if the name of the property selected in the log configuration aspect was one character, and that character was also present in the object name, the log's Item ID would be empty, and the log configuration would be invalid. This problem has been fixed so that one-character property names may be used.</td>
</tr>
<tr>
<td></td>
<td>2578</td>
<td>Prior to installing this patch, the update functions in DataDirect and Display Services could not be used to write data with bad data quality to a history log. This problem has been fixed so that data with bad data quality may now be written to a history log.</td>
</tr>
<tr>
<td></td>
<td>2631</td>
<td>Prior to installing this patch, when updating every value for a month of data sampled at 1 minute intervals, blocks of values failed to get updated within that time range. With this patch all values get updated correctly.</td>
</tr>
<tr>
<td>Web-based Report Scheduler</td>
<td>2484</td>
<td>Prior to this patch, when an Excel spreadsheet containing a chart was scheduled by Report Services with output in HTML format to a report log in History Services, the chart would not be displayed when the generated report was retrieved from the history log. This problem has been fixed so the chart will now be displayed when the report is retrieved from the report log.</td>
</tr>
<tr>
<td>Display</td>
<td>2492</td>
<td>Prior to this release, custom graphic displays built with Display Services could not be embedded in Process Portal A displays as ActiveX controls. This functionality is now supported, and is implemented using the same procedure used for launching a Display IE client with an ActiveX control. This procedure is described in Inform IT Information Manager Display Services Configuration.</td>
</tr>
</tbody>
</table>
### Table 2. Problems Fixed in earlier Patches Which are Included in this Patch (Continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataDirect</td>
<td>2899</td>
<td>The ABBGetOPCDA function no longer recalculates without being explicitly requested. This behavior sometimes gave the impression of a hanging report.</td>
</tr>
<tr>
<td>DataDirect</td>
<td>2563</td>
<td>Two new functions have been added to DataDirect to support writing to history logs with entries that have timestamps with microsecond resolution. The new functions are: ABBWriteOPCHDA (for writing a single entry) and ABBWriteNOOPCHDA (for writing multiple entries).</td>
</tr>
<tr>
<td>DataDirect</td>
<td>2491</td>
<td>If you installed patch 1 for Information Manager version 3.5/2, the new DataDirect OPCDA and OPCHDA functions provided with that patch would not work in multiple-sheet workbooks. This problem has been fixed so the patches will now work both in single-sheet workbooks and multiple-sheet workbooks. <strong>NOTE:</strong> These functions are also installed with patch 6 (this patch), so you are not required to install patch 1 to get this functionality.</td>
</tr>
<tr>
<td>DataDirect</td>
<td>2453</td>
<td>New DataDirect add-in tools to facilitate data access from aspect objects in Process Portal A. See Section 4, Using the New DataDirect Tools.</td>
</tr>
<tr>
<td>DataDirect</td>
<td>2389</td>
<td>The problem whereby the drill up button in the DataDirect PDL dialog would fail to reset properly has been fixed.</td>
</tr>
<tr>
<td>Scheduler</td>
<td>2503</td>
<td>Time-based schedules no longer have time-shift problems when the Information Manager Server temporarily goes off line and misses a scheduled job execution. For example, if a job is scheduled to run every four hours starting at 8:00 AM on August 1st, and the PC is out of service at that start time, prior to this patch, the job would run at four-hour intervals synchronized to the time the PC returned to service, or may not run at all. With this patch, the job will run at four-hour intervals synchronized to 8:00 AM as was originally intended.</td>
</tr>
<tr>
<td>Scheduler</td>
<td>2504</td>
<td>The Information Manager licensing tool no longer checks for a Scheduler license, so the Scheduler is no longer prevented from running due to a missing license.</td>
</tr>
</tbody>
</table>
Table 2. Problems Fixed in earlier Patches Which are Included in this Patch (Continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Portal A</td>
<td>2361</td>
<td>PPA 2.1/2 SP1 or newer is required to pick up this correction. Prior to this patch, when a data access application issued multiple queries through the Process Portal A OPC/DA server, and each query specified a different valid tag, one or more of the queries would sometimes fail with an <em>Invalid Item ID</em> error. For example, this was seen to occur with the DataDirect ABBGETOPCDA function. This problem has now been fixed.</td>
</tr>
<tr>
<td>Softpoints</td>
<td></td>
<td>A memory leak in the ADVOs OPC Connector Data Service was fixed.</td>
</tr>
</tbody>
</table>
Introduction

Review all instructions in this section, and your ABB Support terms and conditions, for precautions, scope of license, restrictions, and limitation of liability and warranties, before installing this software.

In case of difficulties, please contact the Technical Support Group via SUPPORTLINE:
  in the U.S. - (1-800-HELP-365);
  International - (1-614-224-5888).

Install this patch on all Information Manager servers, all system nodes that have the Information Manager Client Toolkit installed, and all remote PC clients that have the Information Manager Desktop tools. There are different preparatory steps required before you install the patch depending on the type of node. These steps are covered in Preparing Your Computer for Patch Installation below.

Preparing Your Computer for Patch Installation

Follow the applicable procedure as described below, depending on the type of node on which the patch is being loaded:
Preparing an Information Management Server

To prepare the Information Management server, stop all processes under PAS supervision and then stop the server via the Process Portal A configuration wizard.

The new functionality provided by this patch requires Process Portal A version 2.1/2 SP1 to be installed locally on the node where you run DataDirect. Further, all data servers from which you will retrieve data must have Process Portal A version 2.1/2 SP1.

To prepare an Information Management server for patch installation:

1. Log on to your computer as the same user that you initially used to install the Information Manager software.
2. Make a complete backup of your system.
3. Exit all Windows applications.
4. Perform the following pre-installation procedures according to the instructions in the referenced sections:
   - Stop All Processes under PAS Supervision on page 14
   - Stop the PPA Server on page 15
   - Stop SQL Server MSSQLServer Service on page 18

Stop All Processes under PAS Supervision

All Information Manager services must be stopped before you can uninstall history. Use the Process Administration Service (PAS). Launch PAS from the Windows task bar by choosing Start > Programs > ABB Industrial IT > System Services > Process Administration, Figure 1.
Then click **Stop All** in the PAS window. **Figure 2.**

**Figure 2. Stopping All PAS Processes**

Close the PAS window when you are finished.

**Stop the PPA Server**

All processes related to the PPA on the Information Manager must be stopped before you uninstall history. This is done via the Configuration Wizard:

1. Launch the Configuration Wizard from the Windows task bar.
Preparing an Information Management Server  

Section 3  Installation

a. Launch the Configuration Wizard from the Windows task bar (reference Figure 3). Choose **Start > Programs > ABB Industrial IT > Operate IT > Process Portal A > Configuration Wizard**.

![Figure 3. Launching the AIP Configuration Wizard](image)

b. In the Configuration Wizard, select the **Stop Server** option, Figure 4, then click **Next**.

![Figure 4. Stop Server](image)

c. In the next dialog, select the server whose processes are being stopped, for example ROC100 in Figure 5, then click **Next**.
d. Respond to the notification that all systems will be stopped on the selected server, Figure 6, by clicking **Apply**.

Figure 5. Selecting the Server To Be Stopped

Figure 6. Notification that All Systems Will be Stopped on the Selected Server
Preparing an Information Management Server  

Section 3 Installation

e. The ABB System Supervision dialog, Figure 7, may be displayed when the server is stopped. If you get this dialog, close it.

![ABB System Supervision Dialog](image)

Figure 7. ABB System Supervision Dialog

f. Exit the Configuration Wizard.

Stop SQL Server MSSQLServer Service

Open the Service Control Panel and stop the service as follows.

1. Open the Services utility via the Windows Control Panel. To do this choose Start > Settings > Control Panel > Administrative Tools > Services.

2. Select MSSQLServer Service in the Services list, then right click and choose Stop from the context menu.

3. Close the Services utility window.
Preparing System Nodes that Use the Client Toolkit

All system nodes that are not Information Management servers (i.e. aspect servers, connectivity servers, and operator workstations) require the Information Management Client Toolkit. For these nodes it is necessary to stop the server via the Process Portal A configuration wizard.

The new functionality provided by this patch requires Process Portal A version 2.1/2 SP1 to be installed locally on the node where you run DataDirect. Further, all data servers from which you will retrieve data must have Process Portal A version 2.1/2 SP1.

To prepare a system node that uses the client toolkit for patch installation:

1. Log on to your computer as the same user that you initially used to install the Information Manager software.
2. Make a complete backup of your system.
3. Exit all Windows applications.
4. Stop the PPA Server on page 15.

Preparing Remote PC Clients

Remote PC clients that run the Information Manager desktop tools, but do not have Process Portal A software installed do not require any preparatory set up prior to installing the patch.
Installing the Patch

The patch is installed via an automated program that performs all required steps, and does not require any operator intervention.

The patch installation program first checks to see if the PAS processes and Process Portal A server are stopped, and stops them if necessary.

Even though the patch installation program is capable of stopping these services, it is recommended that you stop them yourself as described in Preparing Your Computer for Patch Installation on page 13.

Next the program will uninstall History Services, Display Services, Scheduling Services, Softpoint Services, DataDirect, and Desktop Trends.

Then the program will install the new versions of this software.

The installation program must be downloaded to your computer from SolutionsBank. Drill down in the Download Bank using:

- Product Group = Control Products and Systems
- Product Family = Industrial IT - Inform IT
- Product Sub Family = Information Manager 3.5
- Product = All Products
- Document Type = Download

Specific instructions are provided in the Field Notice for this patch. When you find the Download location for Information Manager Version 3.5/2 Patch 6a, install the new software as follows:

1. Click IM 3.5.2 Patch6a.exe, Figure 8.

   IM 3.5.2 Patch6a.exe (Self extracting file) 135MB

   Figure 8. Link for Starting the Patch Installation Program

2. Save the file to an appropriate location on your computer, and then transfer the file to the target computer where the patch is to be installed. To do this:
Section 3 Installation

Installing the Patch

a. When the File Download dialog is displayed, click **Save**.

![File Download Dialog](image1)

**Figure 9. File Download Dialog**

b. Use the Save As dialog to select a location for saving the patch installation executable, then click **Save**, **Figure 10**.

![Save As Dialog](image2)

**Figure 10. Save As Dialog**
The File Download dialog will indicate the download progress, and will indicate when the download is complete, Figure 11.

c. Click **Open** to open the InstallShield Wizard.

![Download Complete](image)

*Figure 11. Download Complete*

The InstallShield Wizard will indicate the progress of the File Extraction, displayed, *Figure 12.*
d. When the file extraction is complete a Windows Command Prompt will open, Figure 13.
e. Click any key to start the patch installation.
Messages will scroll as the installation program completes the various stages. A display similar to the one shown in Figure 14 will be displayed during the installation of each software package.

![Installation Status Display](image1)

**Figure 14. Example, Installation Status Display**

On a history server node you will get the prompt shown in Figure 15. Select **Reatain History Database Instance**.

![Reatain History Database Instance](image2)

**Figure 15. Reatain History Database Instance**
The entire process takes about 10 minutes. When the process is complete, you’ll see the message to restart your system, Figure 16.

![Image of Command Prompt window with installation progress]

**Figure 16. Installation Done**

f. Close the Command Prompt window.

3. Reboot the computer when you are done. Then verify the patch installation as described in **Verifying Patch Installation** on page 26.
Verifying Patch Installation

Use the Information Manager Software Version Information tool to verify that the patch has been installed. This tool is available from the Windows task bar. Choose: Start > Programs > ABB Industrial IT > Version Info, Figure 17.

Check the version for the updated applications as indicated in Figure 18 and listed below. The client install include DataDirect only.

- History Services Version 2.06.01.04 Date: 03/24/2004
- DataDirect Version 2.0.1 (IM 3.5.2P6)
- DataDirectAddin Date: 3/17/2004
- Display Services Server Version 3.5.0 (IM 3.5.2P6) Date: 07/23/2003
- Display IE Version 3.5.2 (IM 3.5.2P6) Date: 07/23/2003
- Report Scheduling Server Version 1.1.0 (IM 3.5.2P6) Date: 07/24/2003
- SoftPoint Server Version 1.0.2
Figure 18. Software Version Information Tool

Remember to recreate any custom data provider configurations that were deleted when Display Services was removed.
Setting Log On Settings for Information Manager Services

The log on user for ABB Process Administration Service and ABB Data Service Supervision must be the same user as specified for the PPA service account. This allows related services (History for example) to log onto the Information Manager server where they will run. The service account is configured via the Configuration Wizard System Software User Settings dialog when Process Portal A is installed.

To set up the service account for History services:

1. Get the user name for the PPA service account from the Configuration Wizard System Software User Settings dialog.
   a. To start the wizard, from the Windows task bar choose Start > Programs > ABB Industrial IT > Operate IT > Process Portal A > Configuration Wizard.
   b. Select the System Software User Settings option, and click Next.

   The user name for the Service Account is indicated in the Service Account field, Figure 19.

![Configuration Wizard - System software User Settings](image)

*Figure 19. User Name for AIP Service Account*
2. Open the Services utility via the Windows Control Panel. To do this choose Start > Settings > Control Panel > Administrative Tools > Services.

The ABB Process Administration Service is located near the top of the services list. This service must be stopped before you change the Log On settings.

3. Select ABB Process Administration Service in the Services list, then right click and choose Stop from the context menu, Figure 20.

![Services Utility](image)

*Figure 20. Accessing the Windows Services Utility*

4. Wait for the service to stop. Stopped status is indicated when the Status column changes from Started to no entry (blank).

5. Once the service is stopped, double-click on the service to open the Properties dialog (or right click and choose Properties).
6. Go to the **Log On** tab, select **This account:**

Then enter the user name and password, Figure 21.

7. Click **OK** to apply the changes and then exit the Properties dialog.

8. Repeat this procedure to change the Log On specification for the **ABB Data Service Supervision**. This service should already be stopped, as indicated by no entry in the Status column.

9. When you have finished with both services, restart the ABB Process Administration Service - select the service, right-click and choose **Start** from the context menu.
Setting the ADO Data Provider to Automatic

This procedure describes how to edit the ADO data provider to support the IM Oracle database. Specifically you must edit the -dbname argument to match the ODBC Data Source Name assigned when you created the ODBC data source.

To edit the ADO data provider:

1. Start the ADSS Config function from the Windows Control Panel. To do this, from the Windows task bar, choose Start > Settings > Control Panel. Then double-click on the ADSS Config Icon, Figure 22.

![Double-click ADSS Config Icon to Display the ABB Data Service Supervision Config Dialog](image)

Figure 22. Opening the ABB Data Services Supervision Configuration Dialog
2. Click the (+) button next to Supervision to expand the navigation tree and show the available data providers. Then select the ADO data provider, Figure 23.

![Figure 23. Selecting the Existing ADO Data Provider](image)

The data provider must be stopped to configure its attributes. This is the default state. If the data provider is Started, click the Stop button to stop the data provider.

3. Click the + symbol next to the ADO data provider to show the data provider attributes, then click on Arguments, Figure 24.

![Figure 24. ADO Arguments for Oracle](image)
4. Configure the -dbname argument as described in Table 3 and shown in Figure 25. All other arguments described in this table are shown for reference only and must be left at their respective default values.

Table 3. Argument Specifications for ADO Data Provider

<table>
<thead>
<tr>
<th>Argument</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>-port</td>
<td>19014</td>
</tr>
<tr>
<td>-channel</td>
<td>0</td>
</tr>
<tr>
<td>-pass</td>
<td>history - Password for the history user.</td>
</tr>
<tr>
<td>-server</td>
<td>localhost</td>
</tr>
<tr>
<td>-dbtype</td>
<td>ODBC</td>
</tr>
<tr>
<td>-ReconnINT</td>
<td>10 - Retry interval (in seconds) for reconnecting to the Oracle database if the data provider is disconnected from the Oracle database.</td>
</tr>
<tr>
<td>-user</td>
<td>history - Username for the history user.</td>
</tr>
<tr>
<td>-dbname</td>
<td>Enter the assigned ODBC Data Source Name. Scroll to the -dbname argument in the list, then enter the name (for example: local, with spaces before and after).</td>
</tr>
<tr>
<td>-name</td>
<td>DBA</td>
</tr>
<tr>
<td>-FatalErrors</td>
<td>“03114” (quotation marks required) - Indicates that oracle error code “03114” for disconnect will be considered fatal.</td>
</tr>
</tbody>
</table>

Figure 25. Detailed View of ADO Arguments

Enter ODBC Data Source Name (see ODBC Data Source control panel to verify name)
5. Set the StartupMode for this data provider to **AUTOMATIC**.

The default setting for StartupMode is MANUAL. This means the data provider will not start up automatically when you restart the computer. It is recommended that you change the StartupMode to AUTOMATIC to avoid having to manually start the data provider after a reboot. To do this, click the **StartupMode** argument, and enter **AUTOMATIC** in the Argument Value field, Figure 26.

6. Click **Save** to save the changes.

7. To start the ADO data provider, select it and click **Start**.

8. Then click **Close** to exit this dialog.

This concludes the procedure for configuring the ADO data provider for Oracle access.
Configuring the Softpoint Server

The Softpoint Service Provider must be reconfigured to connect to the SQL Server database. This is done via the PPA Configuration Wizard which must be run locally on the designated Softpoint Server node. To do this:

1. At the Softpoint Server node, launch the Configuration Wizard, Figure 27.

![Figure 27. Launching the Configuration Wizard](image)

2. Double-click the Softpoint Server icon, Figure 28.

![Figure 28. Starting Softpoint Server Configuration](image)
3. Use the dialog in Figure 29 to enter the MMS address for the machine where the Softpoint Server will run. The default is the local IP address. It is recommended that you enter 127.0.0.1. This is Microsoft’s generic address for localhost. By using this address the Softpoint Server configuration will not be affected if the machine’s IP address is changed.

![Figure 29. Specifying MMS Address](image)

4. Select No, Figure 30, when asked to reset the database.

![Figure 30. Softpoint Database Reset (No)](image)
5. Click **Next**. This displays a configuration summary, **Figure 30**.

![Figure 31. Configuration Summary](image)

6. Verify your configuration settings then click **Apply**. This completes the Softpoint Server configuration. Exit the Configuration Wizard.
Bringing a New Softpoint Configuration On-line

Whenever you create new softpoint objects, or make changes to existing softpoint objects, the new configuration will not go into effect until the changes are brought on-line. You can do this in either the Control or Object Type structure.

If the communication quick-start file generating under the Bring Online tab fails, you can revert to a previously saved quick-start file.

To bring a new softpoint configuration on line (reference Figure 31):
1. Select the **Softpoint Process Objects** group in either the Object Type or Control structure (Control structure is shown in Figure 31).
2. Select the **Softpoint Configuration** aspect.
3. Check the **Communication** check box, and then select either the **Full** or **Incremental** option according to the guidelines below.

The **Incremental** option brings on-line only those changes that have been made since changes were last brought on-line. Typically you can use this option. You will be prompted when the **Full** option is required.

4. Click **Apply**. Before the process begins you will have an opportunity to specify whether or not to set the currently running version as a safe version, Figure 32. This lets you revert to the safe version if the new one fails to come on-line.

![Figure 32. Bringing the Softpoint Configuration On-line](image-url)
5. It is recommended that you set the currently running version to safe by clicking **Yes** for the prompt shown in **Figure 32**.

![Figure 33. Setting the Currently Running Version as Safe](image)

The status bar shown in **Figure 33** is displayed while the quickstart file is being created. During this time the current softpoint configuration is still running.

![Figure 34. Status Indicator](image)

You can change to another aspect while generating is in progress. The progress bar will remain visible.

The indicator shown in **Figure 34** is displayed while the new configuration is being brought on-line. During this time, softpoint processing is suspended, current values and new inputs are held. This process is generally completed within five minutes, even for large configurations. The process is complete when this message box is removed.

![Figure 35. Quickstart Indicator](image)
**Restart Calculations**

If your calculations use Softpoints, then you must disable and enable Calculations as follows.

1. Select the **Calculations Status Viewer** aspect located in the Service Structure > Services > Calculation Server, Service object.
2. Select all calculations and use the aspect context menu to **Disable** the calculations.
3. After they are disabled use the aspect context menu to **Enable** the calculations.
Section 4 Using the New DataDirect Tools

This section provides operating instructions for using the new Industrial IT Process Values and Industrial IT History Values dialogs, and for using the new DataDirect functions installed by this patch. This section also describes how to hide/expose any add-in tool using the new View tab on the Options dialog.

The new dialogs for process and historical data access feature an object browsing tool that more closely resembles the Process Portal A Plant Explorer. These dialogs also let you choose whether to execute a query on an ad-hoc (one-time) basis, or as updateable function such that the spreadsheet may be used as a re-executable report.

The new dialogs are available via the DataDirect toolbar and menu by default, Figure 35. Also available by default are the Log-in, SQL, PDL, Options, and Online Help dialogs. The TCL Unit Array, Message Log, and original Process and History Values dialogs which were previously available are hidden by default. Any hidden function may be exposed, and any exposed function may be hidden via the View tab on the Options dialog. This is described in Setting Up the DataDirect Menu and Tool bar on page 45.

DataDirect Menu

DataDirect Toolbar

Process Values

History Values

Figure 36. DataDirect Add-in Toolbar and Menu
Log In

The log-in process for the new dialogs and functions is different. When using these new add-in tools, you must log on to a server to get a license; however, you are not required to connect to a specific data server. Since the object browsing tool in these dialogs operates in a manner that is similar to the Process Portal A Plant Explorer, you will have access to all aspect objects within the Aspect Directory (all objects on all servers in the Aspect System).

The dialogs and functions that were originally provided by the DataDirect 2.0 installation still require you to log-in AND connect to a specified data server using the Log-in dialog.

Using the New Process and History Values Dialogs

Operation of the new Process and History Values dialogs, Figure 36, is very similar to the original dialogs described in DataDirect Operation. The new functionality and differences in operating procedures are described in the following sections:

- **Browsing and Selecting Objects** below
- **Specifying One-time Data Access or Reusable Formulas** on page 44
- **Interrupting the Retrieval of Selected Objects** on page 44

These dialogs do not support write access to process and history objects. For process objects you may use the ABBWriteOPCDA function as described in ABBWriteOPCDA on page 47. There is no equivalent function for write access to history objects in this patch; however, you may still use the ABBEditLog and ABBNEditLog functions as described in DataDirect Operation.

Browsing and Selecting Objects

The browser operates in a manner similar to the Process Portal A Plant Explorer. It provides access to all aspect objects represented in the Process Portal A Aspect Directory. If you need to access a process object or historical log that is not represented in the Process Portal A Aspect Directory, then you must use the older version of the Process or History Values dialog.
Figure 37. New Process and History Values Dialogs
Specifying One-time Data Access or Reusable Formulas

The **Formula** and **Data Only** radio buttons, Figure 37, let you choose whether to execute a one-time data request, or enter a reusable formula which will be executed each time the spreadsheet is updated.

For one-time data requests, select **Data Only**.

For reusable formulas, select **Formula**.

**Figure 38. Output Options**

Interrupting the Retrieval of Selected Objects

When you select an aspect object in the left hand pane of the object browser, the browser will attempt to display all properties (or property logs) for the selected object. When the selected object has a large number of properties it may take the browser several minutes to finish retrieving all the properties. You may interrupt the retrieval process at any point by clicking the **Cancel** button in the retrieval status dialog, Figure 38. This will result in a partial list of object properties (or property logs), containing as many properties as the browser was able to retrieve at the time the **Cancel** button was clicked.

**Figure 39. Interrupting the Retrieval Process**
Setting Up the DataDirect Menu and Tool bar

The View tab, Figure 39, lets you select which add-in tools to show or hide on the DataDirect tool bar and menu bar. Add-in tools are grouped in two categories: Industrial IT (new add-in tools) and Inform IT (original add-in tools). Each add-in tool has a separate check box for showing/hiding the add-in tool in the DataDirect menu and/or the corresponding tool bar.

You can select or deselect all check boxes in Menu or Toolbar column for either the Industrial IT or Inform IT category by clicking the corresponding button. You can also restore the default settings at any time. Figure 39 shows the default settings when you initially install the patch.

![Figure 40. View Tab](image-url)
Functions

This version of DataDirect provides four new functions:

These functions will not work with any Excel versions before Office 2000.

- **ABBGetOPCDASimple** on page 46
- **ABBWriteOPCDA** on page 47
- **ABBGetOPCDA** on page 48
- **ABBGetOPCHDA** on page 49
- **ABBGetOPCHDAAggregates** on page 52

### ABBGetOPCDASimple

The ABBGetOPCDASimple function will return real-time object data for one OPCDA item. Refer to *DataDirect Operation* for general guidelines on entering functions. The syntax for this function is described below:

\[=\text{ABBGetOPCDASimple}(\text{ObjectName}, [\text{Server}])\]

where:

- **ObjectName** is the tag name for the object. You can use the OPC browser in the original Process Values dialog to find object names.
- **[Server]** specifies the OPCDA server ProgID. This defaults to the Process Portal A OPCDA server when the parameter is left undefined.

Enter all parameters as text strings with double quotes.

Example:

\[=\text{ABBGetOPCDASimple}("H0000X000K-000000:MEASURE", "ABB.AfwOPCDASurrogate")\]

This function returns an array of data (two columns, one row). To manually execute the function, select a 2 x 1 range cells, then place the cursor in the formula bar and press Ctrl-Shift-Enter.
ABBWriteOPCDA

The ABBWriteOPCDA function lets you update process values. The syntax is as follows:

=ABBWriteOPCDA (objname, value, [Server])

where:

ObjName is the tag name for the object. You can use the OPC browser in the original Process Values dialog to find object names.

Value is the new value to be applied to the specified attribute.

[Server] specifies the OPCDA server ProgID. This defaults to the Process Portal A OPCDA server when the parameter is left undefined.

Enter all parameters as text strings with double-quotes, with the exception of the value which may be entered as another data type, for example: integer, as applicable.

Example:

=ABBWriteOPCDA(“H0000X000K-000000:MEASURE”, 100
"ABB.AfwOPCDASurrogate”)
The ABBGetOPCDA function will return real-time object data for specified OPCDA items. It will search for all cells containing this function and formulate one OPC call to retrieve the specified data for all and cause all cells to be populated with the correct data. This function is automatically executed when you generate a query for using the new Process Values dialog in the Formula mode as described in Specifying One-time Data Access or Reusable Formulas on page 44. If you are entering a manual query for process data, refer to DataDirect Operation for general guidelines on entering functions. The syntax for this function is described below:

```excel
=ABBGetOPCDA(ObjectName[,bTS] [,Server])
```

where:

- **ObjectName** is the tag name for the object. You can use the OPC browser in the original Process Values dialog to find object names.
- **[bTS]** specifies whether or not to return the time stamp with each value. Enter bTS as a boolean value:
  - TRUE = return time stamps
  - FALSE = do not return time stamps
- **[Server]** specifies the OPCDA server ProgID. This defaults to the Process Portal A OPCDA server when the parameter is left undefined. If this parameter is used, all cells using this function must specify the same progID.

Enter all parameters (except bTS) as text strings with double quotes. bTS is a boolean.

Example:

```excel
=ABBGetOPCDA(“H0000X000K-000000:MEASURE”, TRUE
"ABB.AfwOPCDASurrogate")
```
ABBGetOPCHDA

The ABBGetOPCHDA function returns a specified number of values for the specified history log object. By default this function retrieves three columns of data: Time Stamp, Data Quality, and Value. You can turn off the Time Stamp and/or Data Quality via the Options dialog.

You can generate a query for this function using the new History Values dialog in the **Formula** mode as described in Specifying One-time Data Access or Reusable Formulas on page 44, or you can enter the function manually. Refer to DataDirect Operation for general guidelines on entering functions. The syntax is:

```
=ABBGetOPCHDA(Logname, Interpolation, Start Time, End Time, MaxCount [,Format Date] [,Server])
```

where:

- **Logname** is the name of the log whose data you want to retrieve. You can use the OPC browser in the original History Values dialog to find log names.

- **Interpolation** is the type of calculation performed by the log. The available options depend on the connected OPC server. You may use the ABBGetOPCHDAAggregates function to get the list of available aggregates.

- **Start/End Time** these specify the time range for which data will be retrieved.

- **MaxCount** specifies the number of values to return. This in combination with the Time Span for Retrieval divides the time range into discrete intervals for which data values are returned.

- **[Format Date]** is an optional parameter that lets you specify whether to use standard Excel formatting (n) or DataDirect formatting (y), and whether to include a column for fractional seconds adjacent to the timestamp column (m), for example: **nm** or **ym**. See Formatting the Date below.

- **[Server]** specifies the OPCDA server ProgID. This defaults to the Process Portal A OPCDA server when the parameter is left undefined.

Enter all parameters (except MaxCount) as text strings with double quotes. For start time and end time, separate the date and time with a space. MaxCount is an integer.
Example:

=ABBGetOPCHDA("H0000X000K-000000:MEASURE", "max", "11/3/00 14:30", "11/3/00 19:30", 5, "n", "ABB.AdvHtHistoryHdlr.1")

This function returns an array of data. The width (columns) is based on the log attributes you choose to display via the Data Format tab in the Options dialog (up to four attributes). The number of rows depends on the time range and MaxCount parameter. To manually execute the function, select a range of cells, then place the cursor in the formula bar and press Ctrl-Shift-Enter.

Matching the Number of Returned values with the Number of Rows Selected

The maximum number of values that can be returned in one call is 3200. The number of values returned by the ABBGetOPCHDA function is determined by the MaxCount parameter, and by the number of rows you select in the Excel spreadsheet.

- If MaxCount > selected rows, the excess values are truncated.
- If MaxCount < selected rows, excess rows show N/A (not applicable).

You can use MaxCount to make the number of values returned match the number of rows selected. To do this specify the MaxCount parameter as -1. For example:

=ABBGetOPCHDA("H0000X000K-000000:MEASURE", "max", "11/3/00 14:30", "11/3/00 19:30", -1)

Again, if there are fewer values in the log than there are rows specified, the excess rows are filled in with N/A.

Formatting the Date

Normally, date and time are formatted as specified in the Data Format tab of the Options dialog. If you want to edit date and time information in the spreadsheet, or use this information in Excel charts, you must use the standard Excel formatting instead. To specify standard Excel formatting rather than DataDirect formatting, use the Format Date parameter in the ABBGetOPCHDA function.
Specify the Format Date parameter as follows:

“n” or “N”  DataDirect date and time formats, as specified in the Data Format tab of the Options dialog, are not applied to the timestamp returned by the ABBGetOPCHDA function. Additionally, the returned timestamp is a date data type.

“y” or “Y”  DataDirect date and time formats, as specified in the Data Format tab of the Options dialog, are applied to the timestamp returned by the ABBGetOPCHDA function.

If a Format Date parameter is not provided, then the DataDirect date and time formats, as specified in the Data Format tab of the Options dialog, are applied to the timestamp returned by the ABBGetOPCHDA function. This is the same as specifying formatDate as y or Y.

You may also use the Format Date parameter to specify whether or not to include a column for fractional seconds adjacent to the timestamp column. Adding the m character to the Format Date string will add a column for the fractional seconds adjacent to the time stamp column, for example: m, nm, or ym. If m is not specified there will be no fractional seconds column.
The ABBGetOPCHDAAggregates function returns a list of aggregates supported by the OPCHDA server to which you are connected. This may be used when you are manually entering the ABBGetOPCHDA function rather than using the new History Values dialog. Refer to DataDirect Operation for general guidelines on entering functions. The syntax for this function is described below:

`=ABBGetOPCHDAAggregates([Server])`

where:

[Server] specifies the OPCDA server ProgID. This defaults to the Process Portal A OPCDA server when the parameter is left undefined.

Enter all parameters as text strings with double quotes.

Example:

`=ABBGetOPCHDAAggregates( "ABB.AfwOPCDASurrogate")`

This function returns an array of data (two columns by \( n \) number of rows). To manually execute the function, select a range of cells two columns wide and a reasonable number of rows (about 25), then place the cursor in the formula bar and press Ctrl-Shift-Enter.
ABBWriteNOPCHDA

The ABBWriteNOPCHDA function lets you add multiple entries to a lab data history log, or modify existing log entries. To add a single entry, use ABBWriteOPCHDA on page 56.

This function will not work with Excel versions before Office 2000.

User Authority

User authority must be configured in the aspect system to allow you to update log objects. This is described in Industrial IT 800xA System Security.

Log Entry Specification

The log entry specification contains the values, time stamps and object statuses for each log entry being added or modified. This specification must be entered in the proper format in the spreadsheet. The function references the row/column range where this information is entered. An example specification is shown in Figure 40.

Refer to ABBWriteOPCHDA on page 56 for details regarding values, time stamps, and object statuses.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>90</td>
<td>4/26/01 10:10</td>
</tr>
<tr>
<td>2</td>
<td>92</td>
<td>4/26/01 10:20</td>
</tr>
<tr>
<td>3</td>
<td>94</td>
<td>4/26/01 10:30</td>
</tr>
<tr>
<td>4</td>
<td>96</td>
<td>4/26/01 10:40</td>
</tr>
<tr>
<td>5</td>
<td>98</td>
<td>4/26/01 10:50</td>
</tr>
</tbody>
</table>

**Values**  **Time Stamps**  **Object Statuses**

*Figure 41. Example, Log Entry Specification*
Syntax
Enter all parameters (except the optional fractional seconds) as text strings with double-quotes. The syntax is as follows:

`=ABBWriteNOPCHDA (cmd, logName, theRange, varType, [server])`

where:

- `cmd` indicates whether to insert a new value or replace an existing value. Enter “I” or “A” to insert a new value. Enter “R” or “M” to replace an existing value. You may also use the complete word (Insert, Add, Replace, or Modify)

- `logName` is the name of the log whose data you want to write. You can use the OPC browser to find log names. Refer to DataDirect Operation.

- `theRange` is the range of rows and columns in the spreadsheet where the preformatted log entry specification is located.
  - the Value string
  - timestamp string
  - Optional numeric OPC Quality
  - Optional fractional seconds as a floating point number

- `varType` variant type to which the value is converted - required for PPA-based trend logs, but not for Information Manager-based history logs. For PPA-based trend logs, enter the integer code that matches the data type for the property for which the log is configured, Table 4.

- `[Server]` specifies the OPCHDA server ProgID. This defaults to the 800xA OPCDA server when the parameter is left undefined.
Examples:
To add a log:
=ABBWriteNOPCHDA ("INSERT", "H000X000K-000000,MEASURE", A1:C5, 2)

To modify a log:
=ABBWriteNOPCHDA ("REPLACE", "H000X000K-000000,MEASURE", A1:C5,2)

Table 4. Supported Data Types

<table>
<thead>
<tr>
<th>Integer Code</th>
<th>OPC/DA Data Type(1)</th>
<th>800xA Data Type(2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>17</td>
<td>VT_UI1</td>
<td>Byte</td>
</tr>
<tr>
<td>16</td>
<td>VT_I1</td>
<td>Char</td>
</tr>
<tr>
<td>11</td>
<td>VT_BOOL</td>
<td>VARIANT_BOOL</td>
</tr>
<tr>
<td>2</td>
<td>VT_I2</td>
<td>Short Integer</td>
</tr>
<tr>
<td>18</td>
<td>VT_UI2</td>
<td>Unsigned Short</td>
</tr>
<tr>
<td>3</td>
<td>VT_I4</td>
<td>Long Integer</td>
</tr>
<tr>
<td>19</td>
<td>VT_UI14</td>
<td>Unsigned Long</td>
</tr>
<tr>
<td>22</td>
<td>VT_INT</td>
<td>Integer</td>
</tr>
<tr>
<td>23</td>
<td>VT_UINT</td>
<td>Unsigned Integer</td>
</tr>
<tr>
<td>4</td>
<td>VT_R4</td>
<td>Float</td>
</tr>
<tr>
<td>5</td>
<td>VT_R8</td>
<td>Double</td>
</tr>
<tr>
<td>6</td>
<td>VT_CY</td>
<td>Very Long Integer</td>
</tr>
</tbody>
</table>

(1) As indicated on the Control Connection Aspect
(2) As indicated on the Log Configuration Aspect
ABBWriteOPCHDA

The ABBWriteOPCHDA function lets you add a single entry to a lab data history log, or modify an existing log entry. To add multiple entries in one function call, use ABBWriteNOPCHDA on page 53.

This function will not work with Excel versions before Office 2000.

**User Authority**

User authority must be configured in the aspect system to allow you to update log objects. This is described in *Industrial IT 800xA System Security*.

**Syntax**

Enter all parameters (except the optional fractional seconds) as text strings with double-quotes. The syntax is as follows:

```
=ABBWriteOPCHDA (cmd, logName, logValue, timeStamp, objectStatus [,fractSec] [,opcQuality], varType [,server])
```

where:

- `cmd` indicates whether to insert a new value or replace an existing value. Enter “I” or “A” to insert a new value. Enter “R” or “M” to replace an existing value. You may also use the complete word (Insert, Add, Replace, or Modify)

- `logName` is the name of the log whose data you want to write. You can use the OPC browser to find log names. Refer to *DataDirect Operation*.

- `logValue` is the new value for the log entry.

- `timeStamp` is the time stamp for the entry. When modifying an existing entry the time stamp must be accurate within one second. To get the precise time stamp, you can retrieve the raw data for the log entry as described in *DataDirect Operation*.

- `[fractSec]` Optional fractional seconds specification (floating point).

- `objectStatus` is an option you can use to enter an integer value to associate with this log entry. For example, ObjectStatus may be used to identify...
the user that added/modified the entry. This value defaults to 0 (zero). You are not required to change this value if you choose not to use this functionality.

\[ \text{varType} \]

variant type to which the value is converted - required for PPA-based trend logs, but not for Information Manager-based history logs. For PPA-based trend logs, enter the integer code that matches the data type for the property for which the log is configured, Table 4.

\[ \text{[Server]} \]

specifies the OPCHDA server ProgID. This defaults to the 800xA OPCDA server when the parameter is left undefined.

**Examples:**

\[ \text{=ABBWriteOPCHDA ("INSERT", "H000X000K-000000,MEASURE", "150.25", "9/16/2003 13:22:00", 2,"0")} \]

\[ \text{=ABBWriteOPCHDA ("REPLACE", "H000X000K-000000:MEASURE,Log1", "150.25", "9/16/2003 13:22:00", 2,"0")} \]

### Updating the Excel Spreadsheet

The purpose of using a function (or dialog in the formula mode) is to create a spreadsheet that will be updated each time it is opened or executed via the Scheduling Services. You can also update the spreadsheet on demand.

The functions provided with DataDirect v2.0 are set up to update using the **F9** function in Microsoft Excel. The new functions provided with DataDirect v2.1 will not be updated when the **F9** function is invoked. For these functions you must use the **Calculate Full** function in Microsoft Excel. Calculate Full will update all functions on the spreadsheet, including DataDirect v2.0 functions. Refer to the on-line help for Microsoft Excel for instructions on using this function.